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1. Introduction: Risk comes from French word rischiare meaning run into 
danger i.e. chance or possibility of danger and of exposure to damage consequence. 
So Risk has two parameters:  
 

i. The Chance, Probability, Frequency or Likely hood of the occurrence of an 
accident.  

ii. The Damage consequences to life and property  
 
HAMS-GPS short for “Hazard management Systems and General Programs 
in Safety”, EHS-Software provides comprehensive Solutions in all areas of EHS 
(Environment, Health and Safety). HAMS-GPS has 2-Sets of Software Modules 
as under: 
 

i. Advanced EHS-Modules, 
ii. Standard EHS-Modules. 

  

1.1 Sources of Mathematical Models used in HAMS-GPS Software 
Packages: 

 

i.  "World Bank Technical Paper-55, Techniques for Assessing 
Industrial Hazards" 

ii.  "Chemical Process Quantitative Risk Analysis", American Institute 
of Chemical Engineers, Centre for Chemical Process Safety. 

iii. "Manual of Emergency Preparedness for Chemical Hazards", 
MOEF. 

iv. "Chemical Process Safety Fundamentals  with Applications".  By  
Daniel A. Crowl &  Joseph  F. Louvar 

v. "Process  Safety  Analysis-An   introduction, by  Bob Skeleton. 

vi. Major Industrial Hazards. By John Withers. 

vii. Process Safety Fundamentals.   By Frank P. Lees. 

viii. Guide lines for  Process Equipment  Reliability data  with  data  
Tables.  By American   institute of chemical engineers. 

ix. Specific rules, regulations and guidelines on Seismic studies and 
oil/gas exploration. 

x. International Standards/codes of practices of on storage and 
handling of relevant Petroleum Products and other bulk hazardous 
chemicals involved that have potential for major hazard scenario 
development. 

xi. Meteorological data for the specific site is obtained from Internet. 
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1.2 Comparison between Advanced and Standard Software Packages: 
 

Advantage 
No. 

Advantages of HAMS-GPS Software 
Package 

Standard HAMS-GPS Software 
Package 

1. Advanced Package is a single 
module taking you from Input Data 
to Final QRA-Results without any 
data transfer! 

The standard package that has 
several modules requiring Manual 
data transfer from one module to 
another. 

2. Advanced Package is extremely 
user friendly and does not need 
advanced knowledge of QRA  

The Standard Package requires 
advanced knowledge of HSE and 
QRA. 

3. The Advanced Package enables in 
a single stretch of button clicks all 
simulations from Chemical 
Storages and Properties through 
Scenario Development, SMOD, 
Scenario Simulations for all types 
of Dispersions, Fires, Explosions 
leading to Risk Assessment results 
including FAR, FN-Relation, ISO-
Risk and ALARP in one go.  

The standard module requires 
multiple manual data entry and 
multiple simulations for each 
module separately, resulting in lot of 
Manual Unit conversion of Data from 
one Simulation in to a different Unit 
for another Module and so on. 

4. The Advanced Package Enables 
scale plotting of all Graphic outputs 
on Auto Cad Files, on Graphic Files 
and also on Blank sheets as per 
user defined scale and Wind 
orientation.  

The standard package does not have 
this scale plotting facility. It gives 
fixed scale graphs in vertical 
position only, with no reference to 
wind direction 

5. The Advanced Package under Risk 
Assessment option includes built 
in computation of Risk based 
Investigation (RBI) Matrix.  

RBI-matrix is available in Standard 
package only as a separate module 
and has toi be run after manual data 
entry by taking the data from other 
simulations only. 

6. The Advanced Package ALARP 
diagram has Scale adjustment 
facility so you can see each 
scenario distinctly from other 
closely positioned scenarios, a 
facility unique for any ALAP 
Software available. 

The Standard ALARP Module gives a 
fixed scale ALARP and closely 
falling scenarios all get overlapped 
making difficult to read. 

7 The Advanced Package is specially 
designed for Commercial EHS-
management. 

The Standard Package is specially 
designed for EHS-Research work 

 
2. HAMS-GPS have also Advanced EHS-Training Modules in the 
following Formats: 
 

i. EHS-E-Reading Books available on our Website and Demo 
Modules containing first 16-Slides ids free to down load. The Full 
E-Reading is Licensed per Month, 

ii. EHS-Audiovisual Modules available on CD/DVD provide 
comprehensive research based Training, 

iii. We also provide SKYPE based Internet EHS-Training on a wide 
ranging Topics, 
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iv. We also Custom Build EHS-Training Modules in select languages 
and on Topics Specific to your Industry. 
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3. Stepwise Details of HAMS-GPS Advanced EHS-Software Package: 
 
Risk Assessment involves determination of the two Risk parameters namely:  
 

i. Risk-Frequency of Occurrence, 
ii. Damage Consequences to Life and Property. 

 
Quantitative Risk Assessment (QRA) involves Quantification of these two Risk 
parameters of Chance and Severity of damage consequence. In other words, 
QRA is Pre-creating potential Maximum Credible Scenarios (MCLS) also 
Called Maximum Credible Accident Scenario (MCAS) from a given facility.  
“Maximum Credible” refers to the Worst Scenario from one facility failure 
like main Pipeline, Storage, Reactor etc. 

 
 4. Installation of HAMS-GPS Software: Both Advanced and 
Standard Modules are Run from a Single Main Menu Drive and 
therefore installation Is common for both standard Package and 
Advanced Package. (See HAMS-GPS EHS-Software installation 
procedure). On successful installation The Red “HAMS-GPS EHS-
Software” Icon as shown appears on the Desk Top:  
 
Note: Tool Tips are available for many Dialog items and try to hold curser 
on the Icon at right and see ToolTip popping. There are several ToolTips on 
Buttons, Text Boxes, List Boxes etc. Always try to hold Curser at places for 
ToolTip help. 
 
Main Menu: Both Software Packages are Run from the same Main Menu. To 
open the Main Menu, Click on this HAMS-GPS Icon. You will find a Welcome 
display follow by the Main Menu Drive as under: 
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Fig-1: HAMS-GPS Main Menu Drive with curser pointing to [Risk 

Assessment Studies] option (Curser Position on each option changes its 
colour from Green to Yellow. Arrows against Text in white Text Box show 

various options available. 
 
The Main menu drive contains several List Box buttons that open in to list of 
options available in each button. These and other options available are depicted 
in the above diagram of Main menu drive with bolder fonts and arrow marks for 
easy understanding. You can click on each option List Box button and see the 
dropdown list showing options available in each List Box. Each 
time you click an option button, the list opens and below appears a 
[Home] button which when clicked, the opened List box closes and 
full Main menu drive displayed again as Home state of Main menu drive. 
 

5. Repair HAMS-GPS Module:                                                                       
 
Note: In case Main Menu does not open, it may be Blocked for some 
reason. Nothing to Worry! In that case, you need to Repair the Software by 
opening Start Button->Click on All Programs->Open directory on [Hams-
Gps Safety Software]-> You will find [Hamsrepair] icon. Double click you 
will get Repair dialog as shown below. Click on the [Please click to repair 
HAMS-GPS Module] button. The Module gets repaired and the Main menu 
gats opened!  
 
 
 
 

Safety Audit Modules 
Risk Assessment Options   
Some more EHS studies 
 
Advanced QRA Module 
 
Manage your files /Back-up database files  
 
  
Scenario developer 
In Un-clicked position Shows all Modules 
 
When Clicked, shows only Licensed 
Modules. 
 
Pinup/Pin down Main menu on Clicking. 
 
Unit Converter 
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6. Creating data base of chemicals for physical, chemical properties 
and storage conditions:                                                                                                                   
 
Before you start Risk Assessment study, you need your storage conditions and 
their chemical and physical and toxicity, flammability properties stored in the 
database and develop scenarios for Risk Assessment.  
 
For this purpose you click on the Scenario developer List Box button and you will 
find the following view of Database management and Scenario developer: 

Fig-2: Scenario developer and Chemical Database Management view. 
 
Tool Tips are available for all controls, which are visible on holding the curser on 
the required control. 
 
Carefully study these options.  
 
6.1 Large Number of Chemical data is Preset: 
 
If you open first combo on Chemical Name, you will find series of chemicals. You 
can type first alphabet of the chemical you want, the combo list position moves to 
chemicals beginning with that alphabet. This helps in rapid selection and also to 
check whether your chemical is available. 
 
Open each List box one by one and see the options for selection in each List 
Box. All common Chemical and Physical data are entered and checked by the 
user. You need to enter only Specific Data on Storage of Chemical like Dyke 
Dimensions etc. and you can run the Module. 
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7. Adding New Chemical: To add a new chemical click on the [Add] button 
when a blank form appears as below:           

                                                                              

Fig-3: Menu for adding a new chemical. 
 
Click on the first Combo box and write the Name of new chemical you wish to 
add to the Chemical database with a suffix if same chemical already exists. Then 
open each combo one by one from top to bottom and select property as 
appropriate for your new chemical stored at your unit.  
 
After finishing all the combo boxes, go to property text boxes on the RHS of the 
Combo Boxes and fill up each property for your new chemical. Note there are 3-
Rows of Text Boxes for your chemical data entry. The first 2-Rows are in white 
colour and require only standard data on Physical and Chemical properties of 
your chemical. The 3rd Row of Text Boxes in Green Colour, require specific data 
on Storage of the Chemical. These may be entered keeping note of the Units 
mentioned for each data. 
 
Here Note: TEEL means Temporary Emergency Exposure Limits in ppm. 
You will find these for your chemical from web site. TEEL0 is Safe level, TEEL1 
is mild action, TEEL2 is no irreversible effect and TEEL3 is life threatening 
and irreversible health effect.  
 
Appendix-1 gives TEEL Values of some common chemicals. 
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7.1 Data Entry for Mixtures of Chemicals: Many times you have Mixtures of 
Chemicals and data for these are not available. There is a [Mixture] Button right 
of [Develop Scenario] Button. Click this and you get a Dialog Box as under: 

 
Fig.-3.1: Generating Chemi8cal data for Mixtures of Chemicals. 

 
This Dialog Box allows for up to a Maximum of 6-Chemicals in a Mixture. You 
have to Open the Combo Box on RH-Top Corner where you will fine several 
Chemicals and Select the First Chemical if available in the List and Chemical 
Name and or for Chemicals not available in the Combo Box, manually Enter 
Chemical Name and %-Volume in the Mixture and Mol. Wt. Repeat for all the 
chemicals in the Mixture and the total % by Volume must be exactly 100. Then 
click [Compute] Button and you get all the required Chemical Data. Then Press 
[Insert] Button which gets activated and the data for the Mixture gets entered in 
the corresponding Edit Boxes of Chemical Data.  
 
The Blue Text boxes are specific Storage conditions for a specific storage for 
your QRA study. 
 
If you select an existing chemical from data base, then you will have to enter the 
Blue Text boxes for specific storage conditions which are not put for most 
chemicals as these differ from case to case. 
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8. Edit Existing Chemical Data: To Edit any existing Chemical data, Click 
on [Edit] Button when all Name and next 2-Combo Box Data remains and the 
rest become Blank. To start Editing, you must reselect Chemical Name from 
the first top Combo Box. Then only the Editing process can start. Then 
open other Combo Boxes and select appropriate item from each Combo Box. 

 
9. Creating Scenarios: 
Once you have selected a chemical or created data for a new chemical then you 
click on the [Scenario Developer] button when the scenarios you need to 
simulate for your QRA study get displayed in the Yellow box as shown below: 

Fig-4: Scenarios for QRA study for your selected Chemical. 
To see the Print Preview click on the [Print Preview] button when the Scenarios 
may be seen in full page and also get printed as shown below: 
 

Print 
preview 

0
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9.1 Displaying Scenarios Developed: 

 
 
To close the Scenario developer, Clock on [Home] icon.  
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10. Opening Advanced QRA Module:                                                               
 
After returning to Main Menu by Clicking on [Home] icon, Click on the 
[Risk Assessment Studies] List Box button to open options there 
under as shown below. Note: More options for Risk Assessment are available on 
the next Option Button titled [Other interrelated Study]: 

Fig-5: HAMS-GPS Main Menu Drive with [Risk Assessment Studies] option 
open. 

 
To go back to main menu simply click on the [Home] icon:   
 
 
To start QRA-Study, click on [Advanced QRA-Module] option from list box of 
[Risk Assessment Studies], when the following “Select Organization” Dialog 
appears: 
 

You can either select an 
existing organization or 
create a new 
organization. For first time 
use, a MyCo and Test 
Organizations are 
provided.  
To create a new 
organization click on 
[New Orgn.] button or 

press [Alt][N] and Enter name of  Fig-6: Select Organization Dialog box 
 
Organization under text box “Name of Organization” then Click in the 
Organization List box blank area. (This is very Important to complete creation 
of new organization. By mistake do not click again on [Add New 
Organization] button. If you do so there will be problem and you will have 
to exit.) The name of new organization disappears from “Name of 
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Organization” text box and appears in the name of “Organization List box”. 
Now you should select the organization from List box and the name of 
Organization selected appears in the “Name of Organization” text box. 
                                                                                                                                                  
 
Select MyCo and the MyCo appears in the “Name of Organization” Text box. 
Then click on [Open QRA] Button or click [Alt][O] when the following 
“Quantitative Risk Assessment” dialog box appears as shown below: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig-7: Risk Assessment Simulation dialog with Reference NLG Tank added. 
 
You will find few Chemicals already added in the “Select Reference No.:” box. 
You can just click on any of these chemicals and the chemical name appears in 
the Reference No. Text Box along with all data from the Chemical Database of 
[Scenario Developer] option on the Main Menu. 

 
11. Adding new Chemical to the “Select Reference No.:” box: Click [Add 
Reference No.] button when focus moves to “Reference No” Text box. Type 
Reference No. in the Reference No. Text Box. The Reference No. should be 
normally the name of the Chemical for QRA study. If there are different capacity 
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storage facilities, Chemical name may be suffixed by a word to identify the 
storage of the Chemical. So you can have as many References for one chemical 
for the QRA-Project. After Entering the Chemical name with identifying suffix, 
click inside the “Select Reference No.” Box (IMP: Click in empty space of the 
Box and not on any listed Item).  

 
12. Getting Chemical Data: To get storage data of the Chemical in the Text 
Boxes, click on [Get Chemical data] button. “Select Chemical” Dialog Box 
appears with “Select Chemical Name” Combo Box as shown below:  

 

Fig-8: Select Chemical dialog box. 
 
Select your Chemical from the Combo Box (Type first Alphabet of your Chemical 
to go to the Chemicals starting with the Alphabet) and then search further by 
curser down operation, your Chemical and Click. The Chemical Storage data 
appears in the Text Boxes below. Click on [Insert Data] button and the data for 
the selected chemical gets inserted in the QRA Dialog Box. Then Click [Exit] 
button on the “Select Chemical” Dialog Box to close this Dialog Box. 
 
There can be number of references in the “Select Reference No.” List box as you 
go on creating Reference No. of new QRA Projects.  
  
There are hundreds of Chemical data some with storage conditions. For any new 
chemical or Mixtures of chemicals, not in the database, you have to go to Main 
Menu and add new chemical and its properties and storage conditions as 
described earlier above. To go back to “Select Organization” dialog box, click on 
[Add new/Delete/Select Organization] button on Top of “Risk Assessment 
Simulation” Dialog. 
 
Here LNG is selected as an example that has data regarding storage, from 
“Select Chemical Name” Combo box. After selecting, click [Get data] button. 
Or click [Alt][G]. The following data gets displayed in the [Select chemical] dialog 
box as shown under. If the Program is already run once you will get the Chemical 
name and Storage data at once on clicking the Chemical in the “Select 
Reference No.:” box as shown in the following dialog box: 
 



 15

 
     Fig-: 8A: Select Chemical Dialog box with chemical selected. 

 
13. Source Modeling for Dispersion Simulation: Now click: “Dispersion” 
under “Select Scenario Options” Box. The Primary and Secondary scenarios 
for Dispersion get displayed. By Clicking other Scenario Options, the Primary and 
Secondary Scenarios for these get displayed. Note: The Primary Scenarios are 
only for Information and should not be clicked. Study the different Secondary 
Scenarios and Select any one Scenario for Source Modeling (SMOD).  
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13.1 Selecting Secondary Scenarios and start Do SMOD for Dispersion: 

Fig-: 8B: On selecting Secondary scenario, the [Do SMOD] for Dispersion 
simulation] button gets enabled. 

 
SMOD is quantification of Primary scenario. Now select the first secondary 
scenario for Flash Vaporization of LNG forming Gas Cloud for Puff dispersion. 
You will find the [Do SMOD for dispersion simulation] button at the LHS 
bottom gets enabled. Click this button. “Some more Data Required” Dialog 
opens.  
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13.2 Selecting Some more Data required: 

Fig-9: “Some more data required” dialog box. 
 

In this Dialog Box, there is “Some Chemical Data” Combo Box select LNG. 
Other required data is already taken by the software. If the required Chemical is 
not in the “Some Chemical Data” Combo Box, you will have to manually enter 
all the required data of the Chemical that is neither displayed nor can be found in 
the “Some Chemical Data” Combo Box. Click [Compute] Button on the “Some 
more data required” Dialog Box. The dialog Closes. Now the [Do SMOD for 
Dispersion simulation] Button has changed to [Start Dispersion simulations / 
Redo SMOD] button and Click on this renamed Button. 
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13.3 SMOD Results: 
 

 
Fig-10: SMOD Performed and the button below now displays [Start 

Dispersion simulations / Redo SMOD] 
 
As shown in Fig. above, SMOD has been Performed and the button below now 
displays [Start Dispersion simulation / Redo SMOD]. You can Redo SMOD if 
need be by clicking [No] button. The SMOD results are displayed showing Total 
quantity flashed in Kg. 

A Click on 
this will take 
you back to 
Organization 
Dialog Box. 
 
Click this to 
delete 
selected 
Reference 
 
Click to add 
a new 
Reference 
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13.4 Start Dispersion or Redo SMOD? 

Fig-11: Dispersion / Redo SMOD Yes/NO dialog. 
 

14. Dispersion Simulation: To start Dispersion click [YES] else to Redo 
SMOD click [NO]. Now Click [YES] button and the dispersion dialog opens:                      
 
 
 
 

 
 
 
 
 
 
 

Fig-12: The Dispersion dialog box. 
 

Edit: 
1. Scenario Text  
 
2. Ht. Simulation 
 
 
3. Stability class 
 
 
4. Terrain  
All as appropriate 
 
Click [Redo] to 
Enable [Get Conc. 
(ppm)] button and 
click it to get Conc. 
Values. 
 
 
 
 
 
 Then Click 
[Compute Conc.] 
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14.1 Understanding the Complex Dispersion Dialog Box:  
 
Following Data are available on this Dialog Box: 
 

i. Scenario: Most Important, First you have to Edit the Scenario 
appropriately. For example the default description says D&F stability 
class. You need one stability class at a time. There is “D” in the 
Atmospheric Stability class Combo Box as Default Stability Class. You 
may choose any required stability class from this Comnbo box and then 
Edit the Scenario showing your chosen stability class. Normally you need 
D first and then F as the two Atmospheric stability classes for dispersion in 
QRA study as D is the Most Dominant and F is longest Effect Stability 
Class.  So choose first D stability and the rerun with F stability class later.  
The Scenario Edit Box is followed by the following: 

a. Wind Velocity Selected (Default for Stability Class Selected at the 
Standard Height of Wind Measure of 10 m from Ground Level)), 

b. Modified Wind Velocity at Height of Simulation, 
 

ii. Below Scenario Edit Box, you find the following Edit Boxes: 
a. Height of Release-Default is 1 m, 
b. Height of Simulation Default is 1 m, 
c. Atmospheric Stabilityy Class-Range Coambo Box: A, AB, B, BC, C, 

CD, D, DE, E, EF, F. 
d. Terrain-default Rural. 

iii. Below above series of Edit/Combo Boxes you find the Following: 
a. MGC- i.e. Maximum Groundlevel Concentratyion, 
b. MGC-Diatance from Source in m, 
c. Explosion Mass in Lbm. (This is computed if the Gas is 

Flammable). 
 
iv. Next Edit Boxes are as under: 

a. Maximum Isopleth Concentration at Height of Simulation, 
b. Maximum Isopleth Concentration Distance in m, 
c. Maximum Distance for Simulation-maximum Limit is 50,000 m and 

is Re-alerted after every 10,000 m for continuation of 
Computations. 

v. Above is followed by the following Columns: 
a. Concentration in ppm: Here you find-UEL, LEL, TEEL3/IDLH, 

TEEL2, TEEL1, TEEL0. Note: These are Editable-Click on these 
one by one and Change as needed. For example, for Non-
Flammable, you do not need UEL and LEL so you can change 
these to any other Concentration name. 

b. Next Column of Data is on “Get Concentration in ppm”. This Button 
gets activated by Pressing [Redo] Button and gets Data from 
Preset Values for the Chemical selected. If maximum 
Concentration is Less than the maximum Concentration, then you 
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have to Change the Title of the Concentration in ppm Button text as 
required. 

c. Coloured ovals from Reds to Greens showing levels of Hazards for 
each Concentration, 

d. Begin Point, End Point, Isop. Length (X-Axis), Isop Length (Y-Axis), 
Distance of Max. Isop. From Source in m, Isop Angle suspended 
from Source Point in Deg., Isop. Area in Ha. 

vi. The above is followed by the following: 
a. PROBIT Equations: 
b. [Redo] Button, 
c. [Compute Concentration] Button, 
d. Reports-Combo Box, 

vii. The above are followed by the following: 
a. Time for Stabilization of Concentration Zones of Dispersion. 

Dispersion to stabilize to a fixed Isopleth Zones takes some time 
and this is computed and is unique in Dispersion Modeling, 

b. Final Set of Edit Boxes relates to % Wind Prevalence in 8-
Orientations and this information is used in computing the Profile 
Graphs Contours of Dispersion. 

 
14.2 Getting Isopleth Concentrations and Editing Isopleth Labels: You 
have to click [Redo] Button above the Concentration text boxes. These Preset 
Concentrations in ppm get displayed from Database of Scenario Developer 
option of Main Menu. 
 
Then Maximum Concentration is to be computed. For this click [Compute 
maximum concentration] button. The maximum concentration gets computed 
and the button just clicked becomes [Compute at given concentration]. The 
Software computes the Maximum Isopleth Concentration (ppm) and displays in 
the relevant Text Box. There are other computations also that get displayed. 
Note these.  
 
Here you have to see and compare the values of Maximum concentration 
Isopleth (ppm) and the concentration values for UEL, LEL, TEEL3/IDLH etc. The 
UEL value has to be less than the maximum concentration. This is so here. 
Otherwise you will have to edit and change the default concentrations given by 
the computer from data base to ensure that first the UEL concentration is 
reduced below maximum concentration and title UEL can be changed to Conc-1 
or some other title as felt appropriate. This can be done by click on the [UEL] 
press button and a new Text box with “Conc. 0” text appears.  
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You can either retain this text or edit this text as you like. Then click on the [UEL] 
press button and the “UEL” changes to [Conc. 0] or what ever you text you 
added. Similarly all other concentrations and their titles may be changed as 
suitable. 
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14.3 Computing Maximum Concentration: Then click the Button [Compute 
at given concentration]. 

 

 
Fig-13: Dispersion computed and results displayed. 

 
14.3.1 Re-Running/Editing an Already Run Dispersion: 
 
Once you have done Dispersion and other simulations, to be discussed 
hereunder, for a particular chemical and a particular scenario, you can 
Rerun/Edit dispersion and other simulations quickly, without going through all the 
steps, as per procedure given below: 
 
First you do the following 3-Normal Steps you do for first Run: 
 
Step-1: Select Reference No. in the QRA-Dialog Box. 
Step-2: Select Dispersion (or other simulations) in the Scenario Options List Box, 
Step-3: Select Secondary Scenario already done through SMOD and other 
normal steps, 
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These are the normal steps you do for Dispersion and other Simulations for first 
Run. Once these three normal steps are done, you can go straight to 
Rerunning/Editing Dispersion or other simulations as under: 
 
Step-4: Double click Dispersion or other simulation already done. You will get a 
Message Box asking “Wish to Run/Edit existing simulation?” Click [Yes] 
button. The “Run/Edit Existing Simulation” dialog box opens. This Dialog Box 
for Dispersion is as under: 

Fiog.-13.1: Run/edit Existing Simulation Dialog Box. 
 
Step-5: Click Dispersion (or any other for Rerun/Edit), all the references of 
Simulations Run already appear in the “Select Reference Number” List Box.  
Step-6: Select the Reference No. you wish to Rerun/Edit from this List Box. 
Notice all the Secondary scenarios already Run appear in the “Secondary 
Scenario” List Box. 
Step-7: Double Click the Secondary Scenario, you wish to Rerun/Edit and the 
Simulation dialog box appears. Rerun/Edit this as required and the Rerun/Edited 
secondary Scenario gets stored. 
  
14.4 Setting Distance Limit for Dispersion:  The distance limit for dispersion 
simulation is kept at 10,000 m as default. If the dispersion distance exceeds this 
default value you get a dialog box to continue dispersion with increased distance 
and this continues in steps of 10,000 m till the dispersion can be completed. In 
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case you wish to limit the dispersion distance to a certain maximum distance, 
then, you will have to increase the last Isopleth value and others above if 
required, to enable dispersion within your maximum limit of dispersion distance. 
Maximum Limit is 50,000 m 
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14.5 Studying Results of Dispersion: Carefully study the results of 
Dispersion. 

 
You can Redo by click on [Redo] button.  
 
Note: Height of Simulation is which is kept 1 m as default representing the 
average breathing height of persons, is very sensitive and to be adjusted with 
care to meet your needs. If you want effect on persons at a height say a 
multistory building, then height of any floor may be used as height of simulation. 
For children on ground, use 0.5 m as height of simulation. This may be needed if 
the dispersion is near a school. 
 
Once you do all dispersion scenarios for a chemical, these get displayed in the 
list box at RHS-Top. You can rerun any of these by merely double click on 
“Dispersion” option in the “Select Scenario Options” List Box and dispersion 
scenarios already run, get loaded and you can select and rerun. This Rerun 
options are also applicable to all the 4-Options available in the “Select Scenario 
Options” List Box namely 1. Dispersion, 2. Fire, 3. Explosion and 4. Risk 
Assessment. 
 
15. Understanding Isopleth and Isoelevet: We shall now explain the 
meaning of Isopleth. 

 

Fig-: 14: Isopleth and Isoelevet illustrated. 
 
Now you understand all the results of dispersion simulation. First three columns 
of dispersion results (Col-Nos: 2-4) for Isopleth along X-Axis in m for Begin Point 
of each Isopleth, then End Point, then Isopleth length Then the 5th Column gives 
Isopleth width along Y-Axis. Then the 6th Column gives distance of Begin Point of 
Isopleth from source. The 7th Column gives Isopleth the angle in deg. Subtended 
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by each Isopleth by tangents drawn from source of each Isopleth. Finally the last 
8th Column gives area of each Isopleth in m2. 
 
16. Obtaining Dispersion Reports: Now you can see the out put reports in 
tables and graphs by selecting the type of report from the “Report’s” Combo box 
at the Right hand side bottom. 

 
Now Reports of Dispersion can be displayed from the Report Combo box at the 
RHS bottom. 
 
Click open this Reports Combo box and you will see the following report options: 
 
Concentration levels and distances. 
Concentration Levels and distances for Mixtures. 
Concentration Profile. 
Plot hazard Zones. 
 
16.1 Concentration levels and distances in Tabular form:  You may click 
the first option on “Concentration levels and distances.” You will find the following 
Reports displayed:                                                                                                                       

Fig-15: Dispersion Results as given in the Dispersion simulation Dialog 
box. 
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16.1.1 Entering Population Data: 
Population data is needed for the next Report showing fatality and Injury. To 
enter the Population data click the option on Main menu on “Enter Population 
Density” and you will get the following diagram: 

 
Fig-16: Population Density data entry Dialog Box. 

 
There is option for entering data in any of the 8-Orientations at 0-2 km, >2-4 km, 
>4-6 km, >6-8 km and >8-10 km. There is a wind orientation line in the center 
and there are 8-squares for 8-Orientations. There is another dialog for changing 
the Wind orientation about which we shall tell a little later. For the present we 
shall retain the wind orientation and enter the Population data. This has been 
done as shown.  There is a combo box for selecting the nature of Terrain. We 
have selected “Medium Rural”. 
 
Now click [Preview Report] button and Report no-2 gets displayed as under: 
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16.2 Results of Dispersion for PROBITS i.e. fatality and Injury under 
dispersion: 

Fig-17: Results of Dispersion for PROBITS i.e. fatality and Injury under 
dispersion. 

 
To understand these Results, you will have to understand what is an Isopleth. 
This is described below once again (See also Para-13): 
 
Isopleth is a constant concentration dispersion horizontal cross section 
zone along down wind x-axis and at a height z (normally 1-m average 
breathing height). 
 
In contrast the vertical cross section of a dispersion is called Isoelevet. 
 
16.2.1 Obtaining Graphic Dispersion Reports:                                                      
 
On clicking Plot Graphic reports option on the Reports Combo box, you will get 
the following dialog box to modify orientation and wind direction as under. You 
can change the orientation (Shown by Red line and wind direction shown by 
green line by dragging the lower adjustment bars to right till you reach the 
desired positions for Orientation and Wind: 
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Fig-18: Mapping options for setting orientation and wind direction for 
Autocad/Graphic plot reports. 

 
This dialog box also has options for selecting concentration zones. By default all 
are selected. This can remain. There are three buttons for [Open AutoCad 
Drawing],  [Open Blank drawing] and [Map Hazard Zones on Picture File] for 
plotting the dispersion graphs. So there are three different ways of mapping the 
hazard zones. You can choose as appropriate. Autocad mapping takes Autocad-
2000 file. 
 
16.2.3 Plotting Hazard Zones on AutoCAD Drawing: Click on button [Open 
AutoCAD Drawing] and select the AutoCAD File required to be opened. click 
on [Set Source Point (Zone)] button. The Curser goes to Autocad map with + 
sign curser. With this + sign curser, select Source Point and click. The dispersion 
gets plotted. It may take some time to plot. So on clicking at the Source Point 
wait till dispersion zones are plotted. Following is an example of Dispersion 
Plotted on Autocad map of a Factory: 
 
 
 
 
 
 
 

Reset Green 
Wind Arrow 
and Red N-
Orientation 
lines either 
by directly 
dragging 
with Mouse 
or by 
dragging  
correspondi
ng Slide bars 
 
Select/ 
Unselect 
Conc. Zones 
as required 

Click 
appropriate 
button for 
Mapping 
 
 
 
 
 
 
Set 
AutoCAD 
Drawing 
Scale 
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Fig-19: Dispersion plotting on AutoCAD Map. 

 
Note: The dispersion line graphs may be too thin. To make them bold double 
click on the main blue Title bar of Autocad Drawing  
 

 
On doing so several options appear at the bottom as shown: 
 

 
Now click on the option [LWT] and the lines become bold. 
 
16.2.4 Plotting Hazard Zones on Blank Drawing: Click on button [Open Blank 
drawing].  
 
Plotting Hazard Zones on Picture File: Click on button [Map Hazard Zones on 
Picture File]  The following dialog Box appears (Shown in part): 
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Fig-20: Dialog Box for Plotting hazard Zones on Picture File. 
 
This has number of options as under: 
 
Click on Menu Item “Insert Drawing / Set Scale” and you get the following 
options: 
 
Insert Drawing / Set Scale -> Select Drawing: 
 
 
 
 
 
 
 
Insert Drawing / Set Scale -> Set Scale: 
 
 
 
 
 
 
 
 
 
So there are 5-Options in all as under: 
 

1. Drawing from File: You can open a Drawing File and Plot the Hazard 
Zones, 

2. Screen Capture: You can capture a Map/Drawing e.g. a Map from Google 
Map. 

Select Drawing 
Set Scale 

From File 
Screen Capture 

Select Drawing 
Set Scale User Defined 

Fit to Scale (Vertical) 
Fit to Scale (Horizontal 
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3. User Defined: This option enables Plotting Hazard Zones in the following 
ways: 
 

a. You can insert a Picture File, 
b. You can Use Screen Capture to insert an AutoCAD Map, 

Google Map or a Picture: For this purpose, first open AutoCAD 
File or Google Map or Picture File then Click on “Screen capture” 
Option. Where by the following Dialog appears: 

 

Fig-21: File capture Window on Google Map. 
 
On the “Screen Capture” there is a Red Button for “Capture” of portion of 
Screen behind the “Screen Capture” Window. There is also a Red Check 
Box which if Checked saves the Captured Screen as BMP-File at the 
location choosen which can be used elsewhere also. 
 
Now Click on [Capture] Button where by the Screen portion within the 
“Screen Capture”. If the “Save Captured File” Check Box is Checked, you 
will be first asked to save the Captured File as “Default.BMP file. Choose 
the location and change file name if required and then save. Then Window 
gets captured and also gets inserted in to the  Dispersion Hazard Zone 
Plotting Window automatically as shown below: 
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Fig-22: Captured File on Dispersion Plot Window. 

 
c. Opens a Blank File.  
 

In all these cases, a mini yellow dialog box for setting user defined scale 
appears. You select two points where by the Unit value of distance between 
points is displayed. and insert the value of scale for the distance between 2-
Points selected and click on . [Select Source] button. The User defined Scale 
Dialog Box is.as under showing the Units of Distance selected and also the 
distance value entered by user..: 

 

 
Fig-23: User defined Scale Dialog Box: 

 
Setting Wind Direction: Set Wind direction from “Mapping Options Dialog Box 
as under by catching the green Wind Arrow and moving it to the Orientation 
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required. Red line shows North which is vertical by default by can be changed by 
catching the red line and moving as required. You can also change these by 
Slider Bars below: 

 

 
Fig-24: Mapping Options Dialog Box with Wind and North reset. 
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Move to the point for Plotting the Hazard Zones and Click. Hazard 
Zones get plotted as under: 

Fig-25: Dispersion Plot on Graphic Picture. 

 
Fig-26: Dispersion Plot on Blank Page with selected Orientation. 
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Application of these Techniques of Plotting Hazard Zones: The above 
Techniques of Plotting Hazard Zones apply to all Scenarios-Dispersion, 
Fire and Explosions. 
 
16.2.5 Zooming Option for Graphs: 
  
i. Zooming AutoCAD Dispersion Graph: AutoCad Graphs can be Zoomed 
in and out by selecting Lens-Curser  and dragging on the AutoCad 
area.  
 
Checking dispersion Isopleth length and width: To check distances 
on AutioCad dispersion Isopleth lengths and Widths, Select the 
[Distance] button                 and clicking at begin and end points of 
required Isopleth, you will get distance displayed. Similarly width of Isopleth can 
be checked. 

 
To generate this mapping of dispersion on Graphic map, you have to do the 
following: 
 
ii. Zooming Graphics other than in AutoCad: For all other than AutoCad 
Graphics, you go to Main Menu and click on “Insert Drawing/Set Scale” option 
and find “Zoom” option that opens to 2-Zoom options, Select any one and click 
on the Graph, it gets zoomed in or out as selected. This Zooming facility is 
available for all Graphic Displays. 
 
16.2.6 Plotting Location Points (concentration) in any direction and any 
distance: Click “Open Blank Drawing” button and double click any AutoCad 
file. It will open a blank AutoCad File. Select [Set Location Points (Conc.)] 
button from “Mapping Options” Dialog Box and click at a point on the blank 
AutoCad area where you want the source of release to exist. You will get the 
Scenario description printed at this Source Point clicked. A message box comes 
to click on Location Concentration Point [Yes] [No] buttons. Click on [Yes] 
button and click at any distance away from Source Point. You get distance in m, 
Concentration in ppm, and Hazard Level at this point displayed. You can 
continue to click more Location Points to display distance, conc. And hazard 
levels at these points. To close the Plotting of Location Point Concentrations, 
click on [No] button of Location Point Plotting Dialog box. You can do the same 
after Plotting dispersion on a AutoCad drawing, but the readability of text will 
depend on the blank spaces in the AutoCad drawing. So a blank AutoCad 
drawing is better. Following is a sample of such a plot on blank AutoCad drawing: 
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Fig-27: Location Distance Points of Concentrations and Hazard Levels. 
 
This completes our discussion on Dispersion simulation for one stability class 
and repeat for other stability class as required. Note you normally require D and 
F stability class dispersions. 
 
You can also display dispersion on blank sheet. For this click on [Map Hazard 
Zones on Picture file] button in Mapping options dialog (see Fig-18). A Blank 
sheet appears (see Fig-21). Now Click on “Insert Drawing/Set scale” option on 
main menu on “Hazard Mapping Preview” dialog box   ->Select Scale->Fit to 
page (Vertical) or (Horizontal). We have selected Fit to “Page (Horizontal)” 
option and the following dispersion diagram gets displayed on scaled grid with 
scale displayed at LHS-Top corner: 
 
16.2.7 Plotting Profile and Fatality-Injury Graphs: 
 
From Reports Combo Select “Concentration Profile” option. You get the 
following Profile Graph: 
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Fig.-28: Concentration Profile Graph of Dispersion. 
 

Concentration Profile is Concentration Vs. Distance Graph. If you hold the Curser 
on any position of the Graph line, you get the Exact Concentration and distance 
of that Point. 
 
Menu Options: for Profile Graph: 
 
On the Top Left Corner there is Option for: 
 
Print 
Exit 
 
In the Middle of main Menu Bar you have the following options for Graphs: 
 
Concentration Profile 
Fatality-Injury Profile 

Zoom      Select Distance 
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     Reset 
 
By Selecting “Select Distance”, you get a vertical line and place it on the 
Profile Graph at a distance required and click, you get Profile Graph within 
that limit only. 
 
If you Select “Fatality-Injury Profile”, you get the following fatality-Injury 
Prophile Graph: 
 

Fig.-28: Fatality-Injury Profile Graph of Dispersion 
 
 
Here again you can use Zoom-> Select Distance option to redraw the Profile 
Graph within a Selected Shorter distance as illustrated for Concentration Profile 
Graph earlier. 
 
These Profile Graph options are also available in Fire and Explosion simulations. 
 
This completes our discussions on Dispersion modeling.  
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17. Fire Simulations:                                                                                         
 
Fire and other simulations are very similar to but much simpler than dispersion 
simulations. 
 
Now go to “Select Scenario Options” Dialog Box from where we selected “1. 
Dispersion” option and ran the dispersion simulation step by step. Now you 
select “2. Fire” option and the fire scenarios get displayed. Select the first 
secondary scenario on “CLG-Liquid Main Pipe leak free spread pool fire” 

option. Following is displayed. 
Fig-26: Fire simulation SMOD option. 

Now Click on the LHS bottom button [Do SMOD for Fire simulation]. The 
SMOD is done and results are displayed and the LHS bottom button becomes 
[Start Fire simulation/Redo SMOD]. 
 
Click this button and click [YES] on the [YES][NO] dialog that appears exactly as 
in Dispersion. 
 
The Fire simulation dialog appears. Most Important, First Edit the Scenario to suit 
your need. Then Click on [Compute IHR-for Isopleths]. Following results dialog 
appears. 
 

A click on this 
takes you back 
to Organization 
dialog box 
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Fig-29: Pool Fire Simulation Dialog Box. 
 

Carefully study these fire simulation results. IHR stands for Intensity of Heat 
Radiation in KW/m2. 
 
Note: Once you run all the available Fire scenarios, these get displayed in the list 
box on RHS-Top. Then merely by double click on any required fire scenario, it 
gets loaded and just click [Compute IHR fir Isopleths (KW/m2)] button. So 
once you run scenarios, you do not have to go through each step. You can redo 
all fire scenarios from the list box of done scenarios. 
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17.1 Obtaining Fire Simulation Reports: Now Reports can be obtained from 
the Reports Combo box exactly as in case of Dispersion.                                                
 
Following Report options are available in the Reports combo box: 
 
IHR-Distances. 
IHR-Profile. 
Fire drawings. 
Plot IHR Zones. 
 
First click on IHR-Distances Option and see the following Report: 
 

Fig-30: IHR-Distances for Pool fire. 
 

As in case of dispersion, the second Report under IHR distances is for PROBITS 
i.e. Percent and absolute injuries and fatality. For this it is necessary to enter 
Population densities exactly in the same was as done for dispersion. The 
Population data entered earlier will be there. Second report is found as under: 
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Fig-31: Pool Fire PROBITS i.e. % and absolute Fatality and Injury 
 
Similarly select the next Report option on IHR-Profile and the following result 
comes: 
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Fig-32: IHR Profile of Pool fire. 
 

Now select the next Report option from Reports combo box for Fire Drawings 
and find the following Report: 
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Fig-33: Pool Fire Drawing. 
 

Study the details of Pool Fire drawing. 
 
Next Report is on Plotting IHR-Zones and the procedure is exactly the same as 
for dispersion Plotting. 

 
17.2 Flash Fire Simulation: “Flash Fire” is not a separate Scenario under 
Fire Option. It is a part of “Pool Fire”, “Fire Ball” and “Jet Fire” Scenarios. In 
the Fire Module Dialog Box, when you select a scenario “Pool Fire” or “Fire 
Ball” or “Jet Fire” there is a Combo Box with default selection as “Pool Fire” or 
“Fire Ball” or “Jet Fire” as per your selection. Open this Combo Box you will 
find “Flash Fire” option and select this option, but by selecting “Flash Fire”, the 
Scenario title does not change, so you have to manually change Scenario to 
“Flash Fire”. It is Important to note always, to Edit the Scenario first before 
proceeding further in all cases. Once you correctly Edit Scenario, it gets 
stored and no problem in re-run of the same scenario. Now for “Flash Fire”, 
the Explosion Mass can be directly obtained by remembering exactly which 
Dispersion Scenario has the required Explosion Mass, In that case after 
Selecting “Flash Fire” and Editing the Scenario, Click on [Get Explosion 
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mass (Lbm) from Dispersion] press button. As soon as this button gets 
depressed, all the already run Dispersion Scenarios where Explosion mass 
data exists, appear in the Scenario List box above as shown below: 

Fig-34: Dispersion Scenarios displayed on Depressing [Get Explosion from 
Dispersion] Press button. 

 
Now, if you identify correctly which Dispersion Scenario has the required 
Explosion mass, Double click that Dispersion Scenario and if you have 
done the dispersion simulation, the required Explosion mass gets 
displayed in the [Explosion Mass] Button. However, you can make note of 
Explosion mass in corresponding Dispersion simulation and manually 
enter under “Flash Fire”. This is done by double click on [Get Explosion 
Mass (Lbm)] button and Explosion mass entry Dialog opens where you 
enter the Explosion mass in Lbm which must be noted in dispersion 
simulation.  

 

Fig-35: a. [Explosion Mass] Button and b. “Explosion Mass” data entry 
Dialog box.  

 
 

17.3 Jet Fire Simulations: If you have Pipeline failure case of a Flammable 
Gas or Liquid, as Primary Scenario, you will get “Jet Fire” Option as a 
Secondary Scenario and you can do simulation for Jet Fire exactly in the same 
manner as for Pool Fire. Along with Jet Fire Secondary Scenario you will also 
find Gas Pipe leak “Flash Fire” Secondary Scenario also. If you select this 
“Flash fire” option you will get a Combo containing “Jet Fire” as Default and 
“Flash Fire” as second option in the Combo Box.. 
 
17.4 Fire Ball Simulations: In case of Flammable gas Puff Scenario as the 
Primary Scenario, you will also find a Secondary scenario as Fire Ball and by 
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selecting this Secondary Scenario, you can simulate Fire Ball. Along with the 
“Fire Ball” as Default, the Combo Box has “Flash Fire” option also and this can 
be run. 
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17.5 Rerunning/Editing Fire Scenarios: once done, by a shortcut method: 
See under this under Dispersion and follow the same procedure. 
 
18. Explosion Simulation:                                                                                
 
Explosion Simulation is very similar and you have to start with Selecting 
Explosion option and scenarios get displayed. Now Select a secondary scenario. 
And click LHS bottom Button [Start SMOD for Explosion simulation]. Following 
Dialog appears: 

Fig-36: Explosion simulation for SMOD. 
 

After SMOD is done Important You Must Edit the Scenario as appropriate. Then 
Click on the same button now labeled [Start Explosion simulation/Redo 
SMOD]. Click [YES] option in the [YES][NO] dialog.  Following dialog appears: 
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Fog-34: Explosion Simulation dialog. 
 

Now you have to get Explosion mass. You will have Explosion mass only if you 
have done dispersion of the flammable gas before doing explosion. If you have 
done Dispersion for the scenario for which you need Explosion mass, then: 
 
First Press the [Get explosion mass from Dispersion] press button (Note: 
[Compute Over Pressure (psi)] Button gets Disabled and you have to release 
the Press Button after getting the Explosion Mass). All Scenarios get displayed in 
the Scenario List Box. Now select the scenario required for explosion and double 
click it. You get the following dialog with Explosion mass. Now you must release 
the Pressed [Get explosion mass from Dispersion] Press Button to Enable 
the disabled [Compute Over Pressure (psi)] Button. If you have not done the 
required Dispersion of any Flammable Gas Scenario, then you can manually 
enter the Explosion mass in Lbm by double Clicking the Explosion Mass (Lbm) 
box and a dialog appears for entering Explosion Mass in Lbm and then click [OK] 
button to store the Explosion Mass. Note: The Explosion Mass depends on the 
Size of Puff and time of attainment of maximum LEL-Zone and is computed by 
Dispersion of Flammable Puff Scenario only. So you must do Dispersion and get 
the Explosion Mass (Lbm) and this is displayed on Dispersion Simulation Dialog. 
You can note down this and enter under Explosion simulation manually.: 
 

Fig-37: Explosion Simulation dialog with Explosion mass from dispersion. 

Explosion mass 
appears here 
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Now Press on the Pressed [Get Explosion Mass from Dispersion] button to 
release back to Enable the disabled [Compute Over Pressure (psi)] Press 
Button. 
 
Following results of Explosion appear: 
 
Note: Once you do all the Dispersion scenarios, these get displayed in the list 
box on RHS-Top. Then you can double click on any of these done scenarios to 
load it and run without going through stepwise. If explosion mass does not 
appear on the top RHS-Text box, then click press button [Get explosion mass 
from dispersion]. All Flammable gas dispersions already done, get listed in the 
above List Box. You can double click required one, to get the Explosion Mass 
(Lbm) for this Flammable gas dispersion scenario. After display of the 
Explosion Mass (Lbm), you must press the [Get Explosion mass from 
dispersion] button to release it. Then only the [Compute Over Pressure] 
button gets enabled and you can run the explosion scenario loaded. 
Explosion mass must be displayed in any explosion scenario otherwise 
error message comes. 
 

Fig-38: Explosion simulation results dialog. 
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You can develop reports by selecting Explosion report options from Reports 
combo box. The various reports generated are given below: 
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Fig-39: Report on Unconfined Explosion damages. 
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Fig-40: Report-2 on Explosion for PROBITS. 

Fig-41: Explosion fatality/Injury Profile. 
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Fig-42: Explosion Consequences Diagram. 

Fig-43: Explosion Hazard Limits in m from Source. 
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You can Plot Explosion Hazard Zones on Autocad drawing or Graphic Picture as 
explained under Dispersion. 
 
Rerunning/Editing Explosion Scenarios once done, by a shortcut method: See 
under this under Dispersion and follow the same procedure. 
 
19. Risk Assessment:                                                                                         
 
Risk Assessment is Final stage in QRA study. There are three final Risk 
measures as under: 
 

19.1 Fatality Accident Rate (FAR): is the risk of fatality to Employees 
which is voluntary risk as the employees have accepted to work in the plant 
having known the risks of fatality from accidents of Toxic gas dispersion, fires 
and explosions. FAR is not dependent of Population Density as it assumes 
1000 persons working in a factory and represents how many are at fatal risk. 
 

FAR is defined as under: 
 
1000 people likely to be exposed to work hazard  during an active work 
life  of 40 years 300 days covering a single shift of  8-hours. 
100,000,000 hours / (24 hrs. Per day).(365 days per year) = 11415.5  
years  of  exposure or  say  11000  years:  

 
19.2     ISO-Risk or Individual Risk: is the risk of fatality to neighboring 
population. This is involuntary Risk as the neighboring population has not 
accepted the Risks of the facility in whose neighborhood they live. Individual 
risk is in contours showing Fatality risks in all directions around the factory 
where people live. ISO-Risk is again not dependent density but only shows 
the Fatality Risk Distance for each secondary risk. 

 
19.3 FN-Curve: is the relationship between Frequency (F) and fatality 
Number (N) of potential Maximum Credible Loss Scenarios (MCLS). MCLS 
refers to worst accident from one facility. FN-Curve is dependent on 
Population Density. 

 
It is a Natural law that Higher Fatality accidents have a lower Frequency of 
occurrence. Frequencies are computed for major leaks from vessels computed 
by Frequency-magnitude relation and for Pipeline failures based on the internal 
diameter per meter. In a set of frequency computations for different failure 
scenarios the law of inverse relation between Frequency of failure and magnitude 
of leak may not be strictly inverse relation. The Frequencies are therefore 
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smoothened to conform to the inverse law. So FN-Curve is for Smoothened 
Frequency (F) and Absolute Fatality Number (N). 
19.4 Risk Simulation Dialog Box: Study carefully this Most Complex 

Dialog Box. 
RBI-Matrix: Select Each Scenario and open RBI-matrix Combo Box on 
“Severity” and Select one of the 5-Options for Severity namely: 1. Safe, 2. 
Low, 3. Medium, 4. Medium High, 5. High. Then open “Chance” Combo Box 
and Select corresponding one of the 5-Options. Note, if Severity is Safe, 
then Chance has to be Safe. For Industrial Severity-Chance, High Severity 

Select  
Scenario to 
view full text 
here 

Check Box for 
Un-Select 
/Select all 
scenarios  
 

Chemicals names appear on selecting Scenario Type. Select 
the chemical if you need Risk for only one chemical and 
deselect both option check boxes below. If you need Risk 
assessment for all Chemicals, click “Show all Records” 
check box. Click on “Show selected Records” displays only 
Y under Select column 

Check box is for display of only setting Ys under each data of 
Select column. File option gets enabled and can proceed further.  

YOU MUST either delete or mark Unselect X 
all Scenarios having Zero FAR values; 
Otherwise Error comes in Computing Total 

Check box for display 
of all Ys and Xs under 
Select column. 
 

Select Scenario 
Type for Risk Ass.  

Menu gets enabled 
on Success only 

After setting all the requirements as above, Click [Compute] Button and if Computation is successful, 
the File option on Main Menu gets Enabled as mentioned on Top Left Text Box in Red Alphabets 
otherwise, if Computation is un-successful, the Computation stops, gives an Error Message and 
stops at Error Scenario.  Then You MUST EITHER MARK IT AS X OR DELETE IT by 
pressing [Delete] Button or Click [Compute] Button in Frequency Column and Change Zero 
values.  Then Click this small [Compute] Button to Edit Frequency or Delete Error Scenario. 
[Compute] again if there is Error again, Computation again stops and action to mark as X, Edit 
Frequency or delete required till all errors are removed and Computation is Successful. Now the File 
option on main menu may be clicked to open Risk Simulation Options. Select the required Risk option 
and you get the Output. Following Options are available for Risk Simulation. 
 
Print Preview 
FN-Curve Preview (Cum. Frq Vs. Abs. Ftl) 
FN-Curve Preview (Abs. Ftl) 
FN-Curve Preview (% Ftl) 
F Vs Dist-Curve Preview 
RBI-matrix 

DB-Click and 
Change Y to X 
to Manually 
Unselect 

Click on Check Box to 
display ISO-Conc. and Select 
any one here to Map ISO-
Conc. Dispersion for all 
Scenarios Selected 

Edit Population Density 
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and High Chance is not present and should be avoided. Both Severity and 
Chance are High only in Adventure Sports.  
 

Fig.-44: Risk Assessment Dialog Box (The Most Complex Dialog Box). 
 
This is a Complex Dialog Box and very detailed Instructions are Provided in it. 
Carefully study the text boxes in the above diagram of “Risk Assessment” 
Dialog Box. Normally you need Risk Assessment for all Selected Scenarios. So 
Select Check Box Option “Show Selected Records” and click [Compute] 
button. The number of cases, Cumulative FAR and % FAR Contribution column 
totals get computed for all Selected Records and “File” option from Main Menu 
gets enabled. You can open “File” Option and Select any Sub-option required 
and proceed further. Note: You can proceed further in QRA-Options only for all 
“Selected Scenarios” and NOT For individual Chemical Scenarios although 
you can just view the results in the above dialog box for selected chemical. 
So for enabling “File” option from Main Menu and to proceed further 
always check only “Show Selected Records” Check box. 

 
19.5 Risk Assessment Dialog Box Showing LNG-Fire Scenarios Data and 
File Munu Items: 

Important Note for Printing Risk Assessment Summary: It is required to Printer page 
Setup as landscape before Print Preview option is selected from File->Print Preview. If 
this is not done Error Message Comes to Setup Print page to Landscape. To Setup Print 
Page to note, the Print Preview is available only in PDF-File Format. So you must go to 
Start->Control Panel->Printers and Other hardware->Printers and faxes->Adobe PDF-
>Printer option from Main Menu->Properties->Printing Preferences->General Tab-
>Printing Preferences->Layout tab->Click landscape radio Button->PDF page Size set 
A4->Adobe PDF Settings Tab->Adobe PDF page Size->Set A4->Apply->[OK}. Now you 
can Select from File Menu->"Print Preview" option and your Risk Assessment 
Summary gets Print preview displayed. 
 

Fig.-44.1: Risk Assessment Dialog Box Showing LNG-Fire Scenarios Data and File Munu Items. 
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19.6 ISO-Concentration Dispersion Simulation for LNG-Scenarios: 

Fig.-45.2: Risk assessment Dialog Box Showing ISO-Risk Dispersion 
Simulation Data Displayed. 

 
19.7 Print preview of Risk Assessment Output:                                                                                   
 
Before you take a Print Preview, you have to set printer to landscape in A4 size 
paper. For this go to Control panel and select Printers and Faxes and set paper 
as A4 and Landscape. Then you go to File option in main menu and select Print 
Preview option. You will get the following output: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.-45.3: Print Preview of Risk Assessment output. 

Note: The Risk 
Assessment 
Output is in 
Landscape and 
to enable 
Printing, you 
have to go to 
Control Panel-> 
Printer-> Print 
Preferences-> 
Layout-> Land 
scape->Apply-> 
OK 
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19.8 Print Preview of Individual Risk or ISO-Risk:                                           
 
To Run Individual Risk also called ISO-Risk, File->Individual Risk. You will get 
Individual Risk dialog as below: 

 

 
Fig-46: Individual Risk Dialog Box 

 
Individual Risk data requires Wind Prevalence in 8-orientations as shown and 
Wind Prevalence data needs to be added.. To see Print Preview File->Print 
Preview. You will see the Print Preview. You can print using Print command on 
Print Preview page by clicking the Printer Icon on LHS-Top of Print Preview. IMP-
NOTE: If Wind data is not available, then an error message box comes for 
entering wind data. Enter wind data and proceed further. 

 
19.9 Plotting Individual Risk Contours on Autocad Drawing: 
 
Procedure is same as done for Dispersion Graph Plotting. 
 
Click on [Map Risk contours] Button->Mapping option dialog displayed->Click 
[Open Autocad Drawing] button->Select your Autocad Drawing and double 
click-> Autocad drawing opens->From Mapping Option dialog Click on [Set 
Source point] button->click on Autocad Drawing at the appropriate point where 
the Individual Risk Contours are to be plotted.  You will get the following mapping 
of Individual Risk Contours. Note: If the Graph is too small or too large, you 
Select Size adjustment curser (Magnifying Glass) and drag curser up or down to 
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adjust size as required. Following is an size adjusted Graph of Explosion on 
AutoCAD Drawing:  
 
 
 
 
 
 
 

 
Fig-47: ISO-Risk Contours on AutoCad Drawing. 

 
19.10 Plotting ISO-Concentration Dispersion Graphs for LNG-Scenarios: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Innermost 
curves are 
magnified 
and shown 
below 
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Fig.-47.1: ISO-Risk Dispersion Maps of LNG-Release Scenarios. 
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A magnified view of Individual-Risk contours shows the innermost curves 
as given below: 

 
 

 
 

Fig-48: Magnified view of Risk Counters. 
 
Note, some curves are perfectly circular while others are deformed curves. The 
perfect circles are for Fires and explosions that are not affected by wind while the 
dispersions are affected by wind and wind prevalence being different in different 
orientations, the dispersion ISO-Risk counters get deformed. In the directions of 
wind the Risk distance is less. In the Autocad drawing, the counters are 
smoothened while in the Graphic diagram, there is no smoothening as is 
depicted in the same ISO-Risk counters plotted on a graphic diagram as shown 
below: 
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Fig-49: Risk-Contour Mapping on Goggle Map. 
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19.11 Print Preview of FN-Curve:                                                                          
 
To Run FN-Curve go to File->FN-Curve. You will get the following diagram 
displayed: 
 

Fig-50: FN-Curve. 
 

You will notice that Frequency (F) is on Y-Axis and Fatality Number (N) is on X-
Axis. There are 4-diagonal lines in Red, Orange Green and Dark Green forming 
5-zones of acceptability of FN-points. Top zone above Red is intolerable zone. 
Between Red and Orange lines is Unjustifiable Risk and needs reduction. 
Between Orange and Green is Acceptable Risk. Between Green and Dark Green 
is Negligible Risk and below Dark Green Very low Risk. 
 
20. ALARP:                                                                                                              
 
ALARP is short for “At Least As Low as Practicle”. This is an UK Model from 
Health and Safety Executive (HSE( for acceptability of Risk to Employees and 
neighboring population. ALARP is now integrated in the Advanced Risk 
Assessment System. 
 
To Run ALARP from Advanced Risk Assessment Software, Select Risk 
Assessment option. Click [Start Risk Assessment Simulations] Button. Check 
Records by Click on [Show All Records] Check Box. Either delete or Deselect 
by typing X all Scenarios having zero FAR Values. These will cause error in 
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computation. After ensuring that there are no Scenarios having Zero FAR 
Values, Further you may Deselect also  
One of those Scenarios having Values matching up to 2-D-ecimel Places as 
these would clutter in the ALARP Graphic Display. Once these are done, Click on 
[Show Selected Records] Check Box and the [Show All Records] Check Box 
Gets Unselected autonmatically. Now Click on [Compute] Button. See the 
Cputed value of Total FAR. Now Click on Main “Menu File” Option Select 
“ALARP”. You will find yje following ALARP Diagram showing in 4-Colours the 
complete range of FAR Scale from 0 at the bottom of the inverted Tnriangle till 
100 at the Top. The 4-Colours are Light Blue from 0-10 (The Range of Chemical 
Ibndustry FAR Range, followed by Green fom 10-25 (The Range of Oil/Gas Well 
Drilling FAR, followed by Straw Coloured zone (The Range of Road accidents by 
Cycling, followed by the last zone in Red Colour (Unacceptable Zone for all). 
 
Normally you will find, all FAR Values generally fall in the small lowermost Light 
Blue Zone of FAR Range from 0-10 and your Scenarios would be Cluttered at 
almost just at or little above 0-Point of the scale frpm 0-100. It is necessary to 
Zoom-in the ALARP Diagram to see distinctly the Positions of the Top 4-FAR 
positions. For this, you have to Click “Zoom” option fnrom Main Menu FAR-
Zones visible. You will find a thin [Slider Bar] visible at the Top. Click on the 
[Slider bar] to set Focus on it. Then Hold [UP-Arrow Key] lightly Pressed. You 
will find, the upper portions gradually move out and-Values in the Zones 
Enlarged and the scale also changes. Finally a small lowest part of the Light Blue 
Lowest zone is left in the Scale of 0-0.1 and you will see the Top 4-FAR value 
Scenarpo’s Positions clearly displayed showing their exact positions in the 
ALARP Diagram. If you want ALARP Diagram for next Lower FAR Values, 
Unselect the Top-4 FAR Scenarioa and rerun, you will see ALARP for these. You 
may use any of ALARP views from 0-100 scale to 0-0.1 Scale and Print it or 
prepare a PDF-File and use it in your Reports. You may also Specifically Select 
any 4-Scenarios of interest after Unselecting all by Clicking  on [Unselect all] 
Check Box and Individually Selecting any 4-Scenarios of your Choice and 
Recompute and Rerun ALARP .You can have any number of useful ALARP 
Diagrams as needed. To Zoom-out simply Press the [Down Arrow Key]. You 
can also use [Left], [Right], [Page UP], [Page DOWN] Keys as well to do 
Zooming. 
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Fig-51: Full ALARP Scale view showing 4-Distinct FAR Zones  

Ranging from 0-100. 

 
 

Fig-52: Fully Zoomed-in ALARP Scale view showing Top 4-FAR Scenarios 
in a FAR-Scale of 0-0.1  



 69

 
21. Manage Your Study Files and Backup database Files Option:  
 
Click the [Manage Your Study Files/Backup database Files] List Box whereby 
the  
following Dialog Box Appears:   

 
Fig-53: Manage Your Study Files/Backup database Files Dialog Box. 

 
To create a Folder/Project name, Click on [Create new floder] button when the 
following Dialog Box appears. You can Click [Floder/Project name] Check Box 
and Change Text1 to name of your Folder.Project name. We have done this with 
MyCo and clicked [Create] Button. This Project has appeared in the dialog 
above. 

Fig-54: Folder/File Creation Dialog Box. 
Similarly, Click [File Name] Check Box and add a File Name and Click 
Create. 
 
To backup Database Files, Click on [Open backup Database Files] Button. The 
following Dialog Box appears. 
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Fig-55: Open backup Database Files Dialog Box. 

 
To backup Consultancy Files, Click [Back-up Consultancy files] Check Box 
when, the next Check Box and its Text disappears, the [Back-up] Button 
enables, and the newly created Project MyCo appears. If you have created more 
Projects all these appear. Click the [Check] box to Back-up. 
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Fig-56: Consultancy File Back-up Dialog Box. 

 
Now select the Folder where you want to Back-up this Consultancy Files. 
Naturally, you must first create a Folder named [MyCo-Back-ups]. Select this 
folder and your MyCo Project Files get backed up. 
 
To Check and Restore back-up files, first Uncheck the [Back-up Consultancy 
Files] Check Box, whereby the other Check Box below that disappeared on 
Clicking [Back-up Consultancy Files] Check Box, reappears. Now Check the 
[Check to Restore……….] Check Box whereby the upper Check Box disappears 
and the following Dialog Box appears: 
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Fig-57: Check to Restore back-up files Dialog Box. 

 
If you had any Back-up files these will appear in the Yellow [List Box]. You can 
Check the [Check Box] open and check and if required restore your back files 
by Selecting the particular Backed up file. 
 
Your Project manahement becomes very handy using this Unique Facility not 
available in any HSE-Software. 
 
22.       Comparison between FAR, ISO-Risk, FN-Curve and ALARP:                 
 
FAR Risk of fatality to Employees during lifetime work from 20 yrs to 60 

years. It is independent of Population density as it is for employees 
over 11000 years. 

ISO-Risk Fatality Risk Contours in 16-orientations does not depend on 
Population density. It shows for each scenario, the Fatality risk to 
neighboring population. 

FN-Curve Is relationship between Smoothened Frequency and Absoluty Fatality 
number and is dependent on Population density. 

ALARP Is acceptability of Risk to employees and neighboring population. 
Note FN-Curve may show unacceptable scenarios whileALARP shows 

same scenarios acceptable. This is because, the for high 
smoothened frequencies, the absolute fatality based on population 
density, may not be acceptable while in ALARP, the FAR values 
show acceptable fatality risk to employees based on life time service 
of 40 years. The unacceptable FN-Curve scenarios shows that for the 
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available population density, it is necessary to reduce frequency of 
unacceptable scenarios or reduce populatuion around. 

23 Summary of Advanced QRA Procedure:                                                      
 
Sr. 
No. 

Step in 
Advanced QRA 

Procedure 

1. Add new 
chemical 

Click [Add]->Enter chemical name in top Text  box-
>Open each combo box below select chemical 
property->Enter Physical and chemical properties in 
white Text boxes-> Enter Storage conditions in Green 
Text boxes-> Click Home icon to finish adding new 
chemical. 

2. Update existing 
Chemical data 

Open existing chemical->Enter Storage conditions 
specific to your plant for the chemical in the Green Text 
boxes. 

3. Scenario 
development for 
selected 
chemical. 

Select the chemical->Click on [Develop Scenario]-
>Click on Print Preview. 

4. Creating New 
Organization. 

Click on [Risk Assessment Studies]->Double Click 
“Advanced QRA Module” from List Bix->Select 
Organization Dialog opens->Select and existing 
organization or Click [New Orgn.] button and Enter a 
new organization name-> Click inside New 
Organization List Box-Organization name disappears 
from Text box this completes creation of New 
Organization. 

5. Starting 
Advanced QRA 

After selecting Organization and name of selected 
organization appears in the Text box click on [Open 
QRA] Button->QRA-Dialog appears-> Click on [Get 
Chemical Data] button->Select chemical from “Select 
Chemical Name” Combo box of “Select Chaemical” 
Dialog->Click [Get Data] button->data is displayed if 
data is extered in the chemical data base. If data is 
partial or not there, then Enter data here-> Click on 
[Insert data] button->Click Exit button-> Data gets 
entered in the QRA Dialog box. 

6. Running 
Dispersion 

Select Reference No. from Lust Box and see that the 
selected Reference No. appears in the Text box just 
above. And Chemical properties from data base 
appear in the Text bix below-> Click on Dispersion in 
the “Select Scenario” List box on the RHS.->Primary 
and secondary Scenarios appear-> Select the first 
Scenario or any other if you like->Click on [Do SMOD 
for Dispersion Simulation] Button->:”Some more data 
required” dialog appears->Open combo on “Some 
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More Chemical Data” and select LNG->More LNG data 
Required appears->Click [Compute] Button]-> SMOD 
gets Computed and results appear in the yellow Text 
boxes below->Click on [Start Dispersion 
Simulation/Redo SMOD] button->Click [YES] button to 
Run Dispersion-Dispersion dialog appears     ->Click 
on [Compute Maximum Concentration] button. Note 
the maximum concentration-> Claick on [Get 
Concentration (ppm) button->Concentrations appear if 
entered in the data base. Otherwise enter as required. 
Note concentrations to be less than the Maximum 
concentration. If Concentrations exceed maximum, 
reduce about 10% below the maximum->Change titles 
of Concentration levels if required->Click on [Compute 
at Given Concentration]->Dispersion results appear. If 
End points of Isopleths exceed, Error message 
showing End Point exceeds 10000 m. You may try 
changing “Maximum distance for simulation” in the 
Text box up to 50000 m. Still if any Isopleth end points 
exceed even 50000 m, then you need to reduce 
quantity released. This is obly possible by reducing 
storage qyantity and size of main piping. 

7. Generating 
Reports 

Once dispersion simulation is over open reports 
Combo Box and select repuired Report and required 
Report appears. Foar Plotting hazard Zones option of 
Report you have follow steps for mapping hazard 
zones. 

8. Fire and 
Explosion 
Simulations 

These are very similar to dispersion simulation and 
specific differences may be seen in the detailed 
descriptions in the Detailed help above. 

9. Risk assessment “Click on Risk Assessment” option in the “Select 
Scenario” List box->Click on [Start Risk Assessment 
Simulations] Button->Risk Assessment dialog 
appears.-> Click on Show all Check box. All scenarios 
run get displayed. Check any unselected Scenarios X 
marked and Select it and press Y Key or Deselect any 
scenarion by changing Y to X. -> Click on “Show 
Selected scenarios” Check box->Click on [Compute] 
button->open from “File” option from main menu FN-
Curve and ISO Risk and for these Risk simulations. 

10. ALARP Select “ALARP Comparison Module” from “Other Inter 
Related Study” option in Main Menu->Fill in the Top 5-
FAR Scenarios and their % Contribution and click 
[Compute] button->Click [OK] button-> ALARP 
Diagram gets displayed. 
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24. Conclusions:                                                                                                     
 
The above Help on Advanced Risk Assessment gives a comprehensive 
instructions of all Modules in Advanced Risk Assessment in a very easy to 
understand and executive. All input data Dialogs and outputs and reports are 
illustrated. It is hoped that users of HAMS-GPS users shall have and entertaining 
and educutive sessions with the Software. 
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25. TEEL Values for some common chemicals:   

                                          APPENDIX-1 
No Chemical CASRN TEEL-0 TEEL-1 TEEL-2 TEEL-3 UNITS 

1. Acetaldehyde 75-07-0 10 10 200 1000 ppm 
2. Acetic acid 64-19-7 5 5 35 250 ppm 
3. Acetic Anhydride 108-24-7 5 5 5 200 ppm 
4. Acetone 67-64-1 200 200 3200 5700 ppm 
5. Acetonitrile 75-05-8 40 60 60 500 ppm 
6. Acetylene 74-86-2 2500 2500 2500 6000 ppm 
7. Acrolein 107-02-8 0.03 0.03 0.1 1.4 ppm 
8. Acrylonitrile 107-13-1 2 10 35 75 ppm 
9. Alcohols, C6-C12 (N.O.S.) 68603-15-6 10 30 50 250 mg/m3 
10 Alkylbenzene (C10-C16) 68648-87-3 10 30 50 500 mg/m3 
11. Allyl alcohol 107-18-6 2 2.1 4.2 20 ppm 
12. Ammonia 7664-41-7 25 30 160 1100 ppm 
13. Aniline 62-53-3 5 8 12.5 20 ppm 
14. Anthracene 120-12-7 1.5 4 30 150 mg/m3 
15. Aqua regia (75% hydrochloric + 25% nitric 8007-56-5 0.85 1.6 18 94.5 ppm 
16. Aromatic hydrocarbon solvents; (High 64742-95-6 500 750 750 750 ppm 
17. Arsine 7784-42-1 0.05 0.05 0.17 0.5 ppm 
18. Asbestos 1332-21-4 0.005 0.5 0.5 2.5 mg/m3 
19. Asbestos (Chrysotile) 12001-29-5 0.005 0.5 50 250 mg/m3 
20. Benzene 71-43-2 1 50 150 1000 ppm 
21. Bromine 7726-95-6 0.033 0.033 0.25 8.5 ppm 
22. Butane 106-97-8 800 2400 4000 19000 ppm 
23. Carbon dioxide 124-38-9 5000 30000 30000 40000 ppm 
24. Carbon disulfide  75-15-0 4 4 160 480 ppm 
25. Carbon monoxide 630-08-0 50 83 83 330 ppm 
26. Carbon tetrachloride 56-23-5 10 44 190 520 ppm 
27. Chlorine 7782-50-5 0.5 0.5 2 20 ppm 
28. Chlorine dioxide 10049-04-4 0.1 0.15 1.1 2.4 ppm 
29. Chloroacetic acid; (Monochloroacetic 79-11-8 0.5 1.5 6.6 20 ppm 
30. Chloroform 67-66-3 2 2 64 3200 ppm 
31. Chlorosulfonic acid; (Chlorosulfuric 7790-94-5 1.43 2 10 30 mg/m3 
32. Ethylene oxide; (Oxirane) 75-21-8 1 5 45 200 ppm 
33. Fluorine 7782-41-4 0.1 1.7 5 13 ppm 
34. Formaldehyde 50-00-0 0.3 1 10 25 ppm 
35. Formic acid 64-18-6 5 10 10 30 ppm 
36. Hydriodic acid; (Hydrogen iodide) 10034-85-2 0.035 0.1 0.5 5 ppm 
37. Hydrobromic acid; (Hydrogen bromide) 10035-10-6 3 3 3 30 ppm 
38. Hydrogen 1333-74-0 60000 145000 280000 500000 ppm 
39. Hydrogen chloride;  (Hydrochloric acid)  7647-01-0 0.5 1.8 22 100 ppm 
40. Hydrogen cyanide;  (Hydrocyanic acid) 74-90-8 2 2 7.1 15 ppm 
41. Hydrogen fluoride;  (Hydrofluoric acid) 7664-39-3 1 1 24 44 ppm 
42. Hydrogen peroxide 7722-84-1 1 10 50 100 ppm 
43. Hydrogen sulfide  7783-06-4 0.51 0.51 27 50 ppm 
44. Iodic acid 7782-68-5 0.125 0.125 0.125 2.5 mg/m3 
45. Iodine 7553-56-2 0.1 0.1 0.5 5 ppm 
46. Maleic anhydride 108-31-6 0.2 0.2 2 20 ppm 
47. Mercury vapor  7439-97-6 0.025 0.1 2.05 4.1 mg/m3 
48. Methane 74-82-8 1000 3000 5000 25000 ppm 
49. Methyl alcohol;  (Methanol) 67-56-1 200 530 2100 7100 ppm 
50. Methyl bromide; (Bromomethane) 74-83-9 1 20 50 200 ppm 
51. Methyl chloride 74-87-3 100 100 400 1000 ppm 
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52. Methyl iodide 74-88-4 5 25 50 125 ppm 
53. Methyl isocyanate 624-83-9 0.02 0.025 0.067 0.2 ppm 
54. Methyl mercaptan 74-93-1 0.5 10 47 68 ppm 
55. Methyl parathion 298-00-0 0.2 0.34 0.35 15 mg/m3 
56. Methyl salicylate 119-36-8 0.125 0.4 2.5 12.5 ppm 
57. Methylene chloride 75-09-2 25 200 750 4000 ppm 
58. Naphtha (coal tar) 8030-30-6 100 100 500 1000 ppm 
59. Naphtha (petroleum), heavy catalytic 64741-54-4 6 15 125 500 mg/m3 
60. Nickel carbonyl 13463-39-3 0.003 0.036 0.036 0.16 ppm 
61. Nitric acid WFNA; (White Fuming) 7697-37-2 0.53 0.53 24 92 ppm 
62. Nitric oxide 10102-43-9 0.50 0.50 12.5 20 ppm 
63. Nitroaniline, p- 100-01-6 6 9 150 300 mg/m3 
64. Nitrobenzene 98-95-3 1 3 20 200 ppm 
65. Nitrogen 7727-37-9 60000 145000 280000 500000 ppm 
66. Nitrogen dioxide 10102-44-0 0.50 0.50 12.5 20 ppm 
67. Nitrogen tetroxide 10544-72-6 3 5 5 20 ppm 
68. Nitrogen trifluoride 7783-54-2 10 30 400 800 ppm 
69. Nitrogen trioxide; (Dinitrogen trioxide) 10544-73-7 25 50 100 500 ppm 
70. Oil gas; (Oil fog) z-0035 450 1750 3000 4500 ppm 
71. Oleum; (fuming sulfuric acid) 8014-95-7 1 2 10 30 mg/m3 
72. Oxalic acid, anhydrous; (Ethanedioic acid) 144-62-7 1 2 5 500 mg/m3 
73. Oxygen (liquid) 7782-44-7 35000 100000 280000 500000 ppm 
74. Ozone 10028-15-6 0.1 0.1 1 5 ppm 
75. Phenol 108-95-2 5 15 23 200 ppm 
76. Phosgene 75-44-5 0.10 0.10 0.30 0.75 ppm 
77. Phosphine 7803-51-2 0.3 1.0 2.0 3.6 ppm 
78. Phosphoric acid 7664-38-2 1 3 5 500 mg/m3 
79. Phosphorous pentafluoride 7647-19-0 3 3 15 75 ppm 
80. Phosphorous trifluoride  7783-55-3 4 4 20 150 ppm 
81. Phosphorus (red) 7723-14-0a 0.1 0.3 0.5 4 mg/m3 
82. Phosphorus (yellow) 7723-14-0b 0.1 0.3 3 5 mg/m3 
83. Phosphorus oxychloride 10025-87-3 0.1 0.479 0.5 0.85 ppm 
84. Phosphorus pentachloride 10026-13-8 1 2 4.25 70 mg/m3 
85. Phosphorus pentasulfide 1314-80-3 1 3 5 250 mg/m3 
86. Phosphorus pentoxide 1314-56-3 1 1 10 50 mg/m3 
87. Phosphorus trichloride 7719-12-2 0.5 0.62 2.0 5.6 ppm 
88. Phosphorus trioxide 1314-24-5 0.4 1.25 7.5 40 mg/m3 
89. Sodium hydroxide 1310-73-2 0.5 0.5 5 50 mg/m3 
90. Sodium hypochlorite 7681-52-9 25 75 500 500 mg/m3 
91. Sodium nitrate 7631-99-4 0.4 1 7.5 100 mg/m3 
92. Sodium nitrite 7632-00-0 0.04 0.125 1 60 mg/m3 
93. Sodium oxalate 62-76-0 10 30 50 50 mg/m3 
94. Sodium phosphate 7632-05-5 0.75 2.5 15 75 mg/m3 
95. Sodium salicylate; (Salicylic acid, sodium 54-21-7 40 100 500 500 mg/m3 
96. Styrene 100-42-5 50 50 250 1000 ppm 
97. Succinic acid 110-15-6 7.5 25 200 500 mg/m3 
98. Sucrose 57-50-1 15 30 50 500 mg/m3 
99. Sulfamic acid 5329-14-6 12.5 40 250 500 mg/m3 
100. Sulfanilamide 63-74-1 1 3 20 500 mg/m3 
101. Sulfonic acids, petroleum; (Petrolatum acid 61789-85-3 10 30 50 250 mg/m3 
102. Sulfur 7704-34-9 0.125 0.4 2.5 12.5 mg/m3 
103. Sulfur dioxide 7446-09-5 0.20 0.20 0.75 27 ppm 
104. Sulfur monochloride 10025-67-9 1 1 1 5 ppm 
105. Sulfur pentafluoride 5714-22-7 0.01 0.01 0.01 1 ppm 
106. Sulfur tetrafluoride 7783-60-0 0.1 0.1 2.08 2.08 ppm 
107. Sulfur trioxide 7446-11-9 0.6 2 10 30 mg/m3 

108. Sulfuric acid 7664-93-9 1 2 10 30 mg/m3 
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109. Sulfurous acid 7782-99-2 0.0125 0.04 0.3 1.5 mg/m3 
110. Sulfuryl chloride 7791-25-5 0.4 1.25 7.5 15 ppm 
111. Thionyl chloride 7719-09-7 0.2 0.2 2 10 ppm 
112. Toluene  108-88-3 200 200 510 2900 ppm 
113. Vinyl acetate 108-05-4 5 5 75 500 ppm 
114. Vinyl chloride 75-01-4 1 50 5000 20000 ppm 
115. Xylenes, m- 108-38-3 100 150 200 900 ppm 
116. Xylene, o- 95-47-6 100 150 200 900 ppm 
117. Xylene, p- 106-42-3 100 150 200 900 ppm 
118. Xylenes 1330-20-7 100 130 920 2500 ppm 

 
 


